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Introduction
Microsoft, like most software manufacturors, is constantly moving their products. DDE links have been

the standard to exchange information between applications on Microsoft Windows 3.x (16 bytes). This protocol has been retained with Microsoft Windows 95 and Microsoft Windows NT 4.0 for compatibility reasons, but the developers have to migrate their applications code. In the near future, all these exchanges between graphical applications will use the OLE. One example concerning this evolution is the VBX controls :

               Note: As of Microsoft Office 97, DDE links (Dynamic Data Exchange) are no more supported.

This means that all communications and data exchanges between Microsoft Windows 95 (Windows 98,

NT 5, etc...) applications, will be done by the OLE (Object Linking Embedding) protocol.

Windows 3.x (16 bytes)                                      Windows 95 / Windows NT 4.x (32 bytes)


VBX (Visual Basic Extensions)                             OCX (OLE Control Extensions)


DDE (All applications)                                           DDE and OLE (MS Office 95)





                                     OLE only (MS Office 97)

These controls are no longer supported on 32-byte platforms and are replaced by the OCX which uses the OLE protocol to communicate. Windows 95 and Office 95 are able to share information using DDE and/or OLE, but developers have to abandon the DDE, because of the future releases of these products.

Consequently, all UNIFACE applications using DDE links have to be adapted so that they continue to function. This implies rewriting UNIFACE Proc code in all the forms concerned.

It is very important to undestand that’s because of the market evolutions that has brought about this

situation. UNIFACE is in compliance with these new standards to bring flexibility, and power to the software developers.

Limitations:

MS Word (Version 7.0a) with OLE Automation can give an OLE object to another application, but cannot use the OLE Automation protocol to access objects held by others applications.

This is a limitation explained in the MS Word online help 


UNIFACE brings a set of routines allowing you to reuse the OLE objects shared by other software.

These functions allow you to manipulate these objects through methods and properties.

               DDE links (UNIFACE registers $50 through $53):

UDDEREQUEST 

 
UDDEPOKE 

UDDEEXECUTE

UDDEADVISE 

UDDEUNADVISE 

OLE Automation (UNIFACE registers $12 to $15):


OACREATEOBJECT


OADESTOYOBJECT


OAEXECMULTI (or OAEXECMULTIV)


OAGETCLSLD


OAGETDISPLD

OAGETPROPERTY 

OAINVOKE (or OAINVOKEV)

OASETPROPERTY

Widget functions:

OACRFROMWIDGET 

OACLOSEWIDGET 

OADOVERBWIDGET 

OAUPDATEWIDGET
Services functions:

OAFLOATFORMAT 

OAHELPONERROR 

OASETBASEREG 

OASETLOCALE 

OASHOWERROR
Enumeration functions:

OAENUMNEXT 

OAENUMQUERY 

OAENUMRELEASE 

OAENUMRESET


OLE parameter list data types :

	Type
	Description
	Range of values
	Example

	B
	Boolean value
	0 for False or 1 for True
	B;1

	CY
	currency
	(approx.) +/-1.7E +/- 308
	CY;-59777.15

	E
	empty
	n/a
	E; 

	ERR
	error
	Error codes
	ERR;0x80000042

	I
	integer value
	-2,147,483,647 through 2,147,483,647
	I;123456

	F
	floating point value
	(approx.) +/-1.7E +/- 308
	F;3.141

	S
	strings
	Any string (w/o ;)
	S;UNIFACE Seven

	DT
	date and time
	01/01/1753 ... 12/31/2078
	DT;12/20/1963 08:09:10 (*)

	P
	object pointer
	Any valid object pointer
	P;0x005e5540


(*) These values are either passed as ‘Date and Time’ in the form of ‘mm/dd/yyyy HH:MM:SS’, ‘Date only’ (time is internally set to 00:00:00), or ‘Time only’ (date is set to current date).

Note: For more information on the properties and methods supported by an application, see the

UNIFACE online documentation. The objects, functions, properties and methods handled by an application are defined in a Object Library, and sometimes in a type library (TLB) file.

You can use a file such as ole2view.exe to examine all the OLE capabilities of a Microsoft Windows application. You can download these programs from the Microsoft Internet site, or use those installed by products like Microsoft Visual C++ or Microsoft Visual Basic for Windows 95.

The Dispatch-Id is a pointer used to identify a method or a property. This pointer can be

used instead of a property or method name in the calls to the following functions :

OAINVOKE, OAGETPROPERTY and OASETPROPERTY.

Error messages returned by OASHOWERROR :
1000: General failure: <Text>

This error can occur in several situations. An explanation of the situation is given after the error text.

1001: Invalid format spécification

The format passed to the OAFLOATFORMAT function is invalid. The default %lf is used.

1002: Invalid locale id (Language)

The locale identifier passed to OASETLOCALE function is not valid.

1003: Invalid base register (1..96)

The number of the base register passed to the OASETBASEREG function is not valid. This number must be in the range 1 through 96.

1004: Out of memory

The application does not have enough memory to complete its operation.

1005: OLE Exception: scode=<number>

This condition is usually raised by the OLE automation server, for example, when a nonvalid parameter is passed to a method. See the server manuals for an explanation of the error code <number>.

1006: Invalid parameter type <string>

The type <string> for a parameter is not valid. See OLE parameter list data types for a listing of possible types.

1007: Invalid parameter value <string>

The value <string> for a parameter is not valid. See OLE parameter list data types for a listing of possible values.

1008: Invalid parameter syntax

The syntax for a parameter passed to the OLE automation server is not valid.

1009: Unexpected result

The application cannot handle the result returned by the OLE automation server.

2001: Invalid name or DISPID

A property method with this name or dispatch id is not available in the OLE automation server. Check the online help of the server for available properties and methods.

2002: Cannot create object. Invalid class name 

The specified class name is not available on the system. Check the spelling of the class name and the installation of the server.

2003: Invalid dispatch pointer 

The dispatch pointer is not valid. Perhaps the object has already been deleted.

2004: Invalid Enumeration pointer.

The enumeration pointer is not valid.

Examples
There are some differences between DDE and OLE communication. Some examples demonstrating what was done in DDE with the Microsoft Office (Word, Excel, etc...) tools when 

applied to the new UNIFACE OLE capabilities follow:

Note: In the following examples,the symbol ; represents the UNIFACE delimiter <GOLD> + semicolon (;) used in the ItemLists.

OLE automation (Example 1): 

This example creates an Excel object and sends data to a Worksheet.

1. Creating the Excel application:

$13  =  "Excel.Application"
; Name of the Excel object

perform "OACREATEOBJECT"
; Creates the object

perform "OASHOWERROR"

; If an error occurs, displays 

the message
This creates the Excel object. If successfully created, the $12 register contains a pointer on this object.

You have to save this value in a local String variable : 

$EXCEL_APP$ = $12

2.  Adding a Workbook:

$12 = $EXCEL_APP$


; Uses the saved pointer

$13 = "pg;workbooks;m;add;0"

perform "OAEXECMULTI"

perform "OASHOWERROR"

where: 

pg means : Property Get 

m means : Method

add is the Method name

When the OAEXECMULTI function has been executed, the $15 register contains another pointer

to access this Workbook.

3. Showing the Excel application:

$12 = $EXCEL_APP$

$13 = "visible"

$14 = "b;1"

perform "OASETPROPERTY"

perform "OASHOWERROR"

4. Copying a string to Excel:

$12 = $EXCEL_APP$

$13 = "pg;ActiveSheet;m;Range;1;s;a1;ps;Value;s;UNIFACE Seven OLE Automation"

perform "OAEXECMULTI"

perform "OASHOWERROR"

The cell “A1” in the current sheet contains :  “ UNIFACE Seven OLE Automation ”.

5. Deleting the Excel object:
$12 = $EXCEL_APP$

perform "OADESTROYOBJECT"

perform "OASHOWERROR"

Note: This action deletes the Excel object and its associated pointers, but the Excel application

is still alive. It is very important to delete all the created objects, because if you run this example

several times, a new object will be added and you can encounter some memory problems.

OLE automation (Example 2): 

This example creates an Excel object and adds a chart to the sheet.

1. Creating the Excel application:

$13 = "Excel.Application"

perform "OACREATEOBJECT"

perform "OASHOWERROR"

This creates the Excel object. If created successfully, the $12 register contains a pointer on this object.

You have to save this value in a local String variable : 

$EXCEL_APP$ = $12

2.  Adding a Workbook :

$12 = $EXCEL_APP$

$13 = "pg;workbooks;m;add;0"

perform "OAEXECMULTI"

perform "OASHOWERROR"
When the OAEXECMULTI function has been executed, the $15 register contains another pointer

to access this Workbook.

$EXCEL_WORKBOOK$ = $15

3. Showing the Excel application:

$12 = $EXCEL_APP$

$13 = "visible"

$14 = "b;1"

perform "OASETPROPERTY"

perform "OASHOWERROR"

4. Get a pointer for the Active Sheet object:
$12 = $EXCEL_APP$

$13 = "pg;ActiveSheet"

perform "OAEXECMULTI"

perform "OASHOWERROR"

When the OAEXECMULTI function has been executed, the $15 register contains another pointer

to access this sheet.

$EXCEL_SHEET$ = $15

5. Tranfer the data to Excel:
$12 = $EXCEL_SHEET$

$13="m;Range;1;S;a1:c2;ps;Value;A;2;2;3;I;1;I;2;I;3;I;4;I;5;I;6"

perform "OAEXECMULTI"

perform "OASHOWERROR"


To transfer the data, the Range method (m) is used, then the Property Set (ps, property : Value).

When the OAEXECMULTI function has been executed, the  'A1:C2' cells contain the data.

6. Get a pointer for a Range object to create a chart.

$12 = $EXCEL_SHEET$ 

$13 = "m;Range;1;S;a1:c2"

perform "OAEXECMULTI"

perform "OASHOWERROR"

When the OAEXECMULTI function has been executed, the $15 register contains another pointer

to access the Range object.

$EXCEL_RANGE$ = $15

7. Creating the graph:

$12 = $EXCEL_SHEET$ 

$13 = "M;ChartObjects;0;M;Add;4;F;0.0;F;0.0;F;200.0;F;100.0;M;Select;0"

perform "OAEXECMULTI"

perform "OASHOWERROR"

8. Copying the Chart values:

$12 = $EXCEL_APP$

$13 = "pg;ActiveChart;m;ChartWizard;11;%%$EXCEL_RANGE$;%\

I;-4100;I;4;I;1;I;0;I;0;I;1;S; ;S; ;S; ;S;"

perform "OAEXECMULTI"

perform "OASHOWERROR"
The results are shown as follows: 
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9. Deleting the Range, Sheet, Workbook, and application objects:

$12 = $EXCEL_RANGE$

perform "OADESTROYOBJECT"

perform "OASHOWERROR"

$12 = $EXCEL_SHEET$

perform "OADESTROYOBJECT"

perform "OASHOWERROR"

$12 = $EXCEL_WORKBOOK$

perform "OADESTROYOBJECT"

perform "OASHOWERROR"

$12 = $EXCEL_APP$

perform "OADESTROYOBJECT"

perform "OASHOWERROR"

OLE automation (Example 3): 

This example inserts an Excel graph object in the UNIFACE OLE Widget and modifies it

dynamically with the fields values painted on the form.

· Creating the form and customizing the OLE Widget.

· UNIFACE 4GL Proc code.

· Implementation. 

1. Creating the form:

Create a form with an OLE container widget and four Numeric fields.

The OLE container widget has the following properties:

Name : CUST_OBJECT


Data Type : Raw Data


Interface : ShortHand : C*


Characteristics : Database
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The EditBox widget has the following properties :
Names : QTR1 to QTR4


Data Type : Numeric or Floating Decimal Point


Interface : ShortHand : C8 or F8

2.  UNIFACE Proc code :

Local String variables are:

ExcelObjectPtr

WbObjectPtr

SheetObjectPtr

Form-level triggers are:
<Execute>
;--- Retrieving the Graph

retrieve/e "CUSTGRAPH"

if ($status < 0)

message "Graphical object not found !"

endif

edit/menu
<Menu>

;--- Creating a pointer on the Graph object

call PMCreateExcel

call PMOpenSheet

call PMOpenOLECtr

$12 = $SheetObjectPtr$

message "Pointer  : %%$SheetObjectPtr$"
<Local Proc Modules>

entry PMCreateExcel


$13 = "Excel.Application"


perform "OACREATEOBJECT"


perform "OASHOWERROR"


$ExcelObjectPtr$ = $12

end

entry PMDestroyExcel


$12 = $WbObjectPtr$


$13 = "Save"


$14 = ""


perform "OAINVOKE"


perform "OASHOWERROR"


$12 = $ExcelObjectPtr$


$13 = "Quit"


$14 = ""


perform "OAINVOKE"


perform "OASHOWERROR"


perform "OADESTROYOBJECT"

end

entry PMOpenSheet


$12 = $ExcelObjectPtr$


$13 = "M;Workbooks;0;M;Open;1;S;C:\Developt\OLE\exchart.xls"


$14 = ""


perform "OAEXECMULTI"


perform "OASHOWERROR"

Note : If you don’t specify the complete Path for the file, Excel looks in the “My Documents” directory.


$ WbObjectPtr $ = $15


$12 = $WbObjectPtr$


$13 = "M;Worksheets;1;S;Sheet1"


$14 = ""


perform "OAEXECMULTI"


perform "OASHOWERROR"


$SheetObjectPtr$ = $15 

end
entry PMOpenOLECtr


$12 = ""


$13 = "CUST_OBJECT.CUSTGRAPH"


$14 = ""


perform "OACRFROMWIDGET"


perform "OASHOWERROR"


$SheetObjectPtr$ = $15

end

Field-level triggers are:

Example with the field QTR1 :

<Value Changed>

$12 = $SheetObjectPtr$

$13 = "M;Range;1;S;A1;PS;Value;S;%%QTR1"

perform "OAEXECMULTI"

perform "OASHOWERROR"

3. Implementation:


1. Creating the Excel document

Open Excel, then select the cells which will be used to modify the graph values.

In this example, select the cells A1, B1, C1 and D1 ( This means that the graph will be

composed of four bars).

In the Insert Menu, choose Chart, on this sheet. Click the selected cells.

The Microsoft Chart Wizard will help you to build the Chart.

Save the file (C:\Developt\Ole\exchart.xls, in this example).

2. Activating the UNIFACE form

Run the form in test mode, right-click the OLE Container, choose Insert, then click

Create From File and enter the Excel file name created in the preceding stage.

Do not click Link.
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The graph is displayed in the form. Use the GOLD-S combination to store it in the database.

Entering values in the four widgets modifies the graph’s appearance.

The result should look as follows:
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OLE automation (Example 4): 
This example creates a new Word document and inserts some values.

1. Create the Word application:
$13 = "Word.Basic"

perform "OACREATEOBJECT"

perform "OASHOWERROR"

This creates the Word application. If successfully created, the $12 register contains a pointer on this

 object. You have to save this value in a local String variable : 

$WORD_APP$ = $12

2. Add a document to the Word object:
$12 = $WORD_APP$

$13 = "FileNew"

perform "OAINVOKEV" 

perform "OASHOWERROR"

Note: The content of  $13 differs according to the MS Word version used, this means that the

Word Basic instructions have to be translated : 


$13 = “FichierNouveau”

; French


$13 = “FileNew”


; English


$13 = “DateiNeuStandard”
; German

3. Show the Word application:

$12 = $WORD_APP$ 

$13 = "ActivateObject"

perform "OAINVOKEV" 

perform "OASHOWERROR"

4. Transfer data to Word:
$12 = $WORD_APP$

$13 = "m;Insert;1;s;This is a sample Text…"

perform "OAEXECMULTIV"

perform "OASHOWERROR"


The 'Insert' method (m) is used to copy a String (s) parameter. 


The value is inserted in the first line of the Word document.

5. Deleting the Word object:
$12 = $WORD_APP$

perform "OADESTROYOBJECT"

perform "OASHOWERROR"

In this example, the values are sent in the document on the first line, without any positioning. 

The following example shows how to work with a preformated document and how to place the values in particular places.

OLE automation (Example 5): 
This example opens an existing Word document, preformated used for a Mailing.

· Creating the document.

· Opening the UNIFACE application.

· Opening the document.

· Sending the data.

· Printing and closing the Word file.

1. Create the Word document:


First open MS Word, create a new document and enter the fixed parts (Titles, headers, etc…).


Atfer that, you have to add the fields wich will receive the data 

Place the cursor where you want to display the value of the UNIFACE Field, then in the Edit menu,choose the Bookmark option.

A dialog box is displayed , enter the name of the bookmark (code in this example) and click Add  :
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The bookmarks are hidden in the document, but you can display them using an option in the Tools menu. 

Repeat this operation for all the dynamic fields that you want to fill. Then save the document in the working directory of your UNIFACE application (Letter_1.doc in this example).

Now enter the UNIFACE Proc code : 
2. Create the Word object:

First, you have to create a local String variable :  WORD_APP

$13 = "Word.Basic"

perform "OACREATEOBJECT"

perform "OASHOWERROR"

$WORD_APP$ = $12

3.  Open the file:

$12 = $WORD_APP$

$13 = "FileOpen"

$14 = "S;%%"Letter_1.doc%%""

perform "OAINVOKEV"

perform "OASHOWERROR"

4. Going to the bookmark code:

$12 = $WORD_APP$

$13 = "EditGoto"

$14 = "S;Code"

perform "OAINVOKEV"

perform "OASHOWERROR"

5. Inserting the value of the UNIFACE field:
$12 = $WORD_APP$

$13 = "Insert"

$14 = "S;%%CODE.CUSTOMER"

perform "OAINVOKEV"

perform "OASHOWERROR"


Repeat these operations for the other bookmarks.

6. Printing the document:

$12 = $WORD_APP$

$13 = "M;FilePrint"

perform "OAEXECMULTI"

perform "OASHOWERROR"

7. Closing the file without saving it:

$12 = $WORD_APP$

$13 = "FileClose"

$14 = "I;2"

perform "OAINVOKEV"

perform "OASHOWERROR"

If you want to print a second version with the next customer, go to the next occurrence and repeat steps  3 through 7.

8. Deleting the Word Basic object:
$12 = $WORD_APP$

perform "OADESTROYOBJECT"

perform "OASHOWERROR"

Traces:
If you get some error messages when you try to test these examples, you can get more information

from UNIFACE OLE Automation :

Open (or create) the file c:\windows\ixtrace.ini which has the following format : 



[Settings]



level=5



file=c:\ixtrace.txt

The number 5 is the higher level. This file is opened in Append mode, all traces are added to the preceding.

This is the ixtrace.txt file when you generate as in example 1 :


[0;0m2 09/20/97 14:13:19 ixtrace.cpp 83 : ========== Trace initiated ==========


[0;0m2 09/20/97 14:13:19 unioadll.cpp 623 : UDLLEVENT: event=1


[0;0m2 09/20/97 14:13:19 unioadll.cpp 623 : UDLLEVENT: event=3


[0;0m2 09/20/97 14:13:19 unioadll.cpp 623 : UDLLEVENT: event=5


[0;0m2 09/20/97 14:13:19 unioadll.cpp 460 : CUniAutoApp::InitInstance: Initialize OLE facility...


[0;0m2 09/20/97 14:13:19 unioadll.cpp 468 : CUniAutoApp::InitInstance: OLE facility initialized.


[0;0m2 09/20/97 14:13:19 unioadll.cpp 475 : CUniAutoApp::InitInstance: OLE was already initialized.


[0;0m2 09/20/97 14:13:19 unioadll.cpp 2252 : 


[0;0m2 09/20/97 14:13:19 unioadll.cpp 2252 : ShowError: number     =""


[0;0m2 09/20/97 14:13:19 unioadll.cpp 2252 : ShowError: application=""


[0;0m2 09/20/97 14:13:19 unioadll.cpp 2252 : ShowError: description=""


[0;0m2 09/20/97 14:13:22 unioadll.cpp 735 : OACREATEOBJECT: szApplication="Excel.Application"


[0;0m2 09/20/97 14:13:22 unioadll.cpp 753 : OACREATEOBJECT: CLSIDFromProgID: hr=0


[0;0m2 09/20/97 14:13:22 unioadll.cpp 771 : CreateObject: GetActiveObject: hr=-2147221021


[0;0m2 09/20/97 14:13:22 unioadll.cpp 794 : OACREATEOBJECT: creating


[0;0m4 09/20/97 14:13:29 unioadll.cpp 813 : Add dispatch 0x00451160 to array


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : 


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : ShowError: number     =""


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : ShowError: application=""


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : ShowError: description=""


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2472 : GetDispatchDriver: ptr="P
0x00451160" => 0x00451160


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2480 : GetDispatchDriver: Attach to 0x00451160


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2536 : GetDispatchId: "workbooks" => 0x23c


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1616 : OAEXECMULTI: GetProperty...


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1619 : OAEXECMULTI: GetProperty done.


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1680 : OAEXECMULTI: AttachDispatch 0x00450a8c


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2536 : GetDispatchId: "add" => 0xb5


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1599 : OAEXECMULTI: OAInvokeC...


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1453 : OAInvokeC: InvokeHelper...


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1472 : OAInvokeC: InvokeHelper done.


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1608 : OAEXECMULTI: OAInvokeC done.


[0;0m4 09/20/97 14:13:29 unioadll.cpp 1712 : Add dispatch 0x004513cc to array


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1716 : OAEXECMULTI: returnvalue="P
0x004513cc"


[0;0m4 09/20/97 14:13:29 unioadll.cpp 1731 : Add dispatch 0x004513cc to array


[0;0m3 09/20/97 14:13:29 unioadll.cpp 1739 : OAEXECMULTI: Detaching and destroying Dispatch Driver...


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1746 : OAEXECMULTI: Release 0x00450a8c


[0;0m4 09/20/97 14:13:29 unioadll.cpp 1748 : Rem dispatch 0x00450a8c from array


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : 


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : ShowError: number     =""


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : ShowError: application=""


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2252 : ShowError: description=""


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2472 : GetDispatchDriver: ptr="P
0x00451160" => 0x00451160


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2480 : GetDispatchDriver: Attach to 0x00451160


[0;0m2 09/20/97 14:13:29 unioadll.cpp 2536 : GetDispatchId: "visible" => 0x22e


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1886 : OASETPROPERTY: dispid=0x22e


[0;0m3 09/20/97 14:13:29 unioadll.cpp 2730 : StrToVar: src="b"


[0;0m3 09/20/97 14:13:29 unioadll.cpp 2776 : StrToVar: type B, value TRUE


[0;0m3 09/20/97 14:13:29 unioadll.cpp 2730 : StrToVar: src="b"


[0;0m3 09/20/97 14:13:29 unioadll.cpp 2776 : StrToVar: type B, value TRUE


[0;0m2 09/20/97 14:13:29 unioadll.cpp 1928 : OASETPROPERTY: SetProperty...


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1931 : OASETPROPERTY: SetProperty done.


[0;0m3 09/20/97 14:13:30 unioadll.cpp 1950 : OASETPROPERTY: Detaching and destroying Dispatch Driver...


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : 


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : ShowError: number     =""


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : ShowError: application=""


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : ShowError: description=""


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2472 : GetDispatchDriver: ptr="P
0x00451160" => 0x00451160


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2480 : GetDispatchDriver: Attach to 0x00451160


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2536 : GetDispatchId: "ActiveSheet" => 0x133


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1616 : OAEXECMULTI: GetProperty...


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1619 : OAEXECMULTI: GetProperty done.


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1680 : OAEXECMULTI: AttachDispatch 0x00451328


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2536 : GetDispatchId: "Range" => 0xc5


[0;0m3 09/20/97 14:13:30 unioadll.cpp 2730 : StrToVar: src="s"


[0;0m3 09/20/97 14:13:30 unioadll.cpp 2754 : StrToVar: type S, value "a1"


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1599 : OAEXECMULTI: OAInvokeC...


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1448 : OAInvokeC: extract parameter #0


[0;0m3 09/20/97 14:13:30 unioadll.cpp 2730 : StrToVar: src="S"


[0;0m3 09/20/97 14:13:30 unioadll.cpp 2754 : StrToVar: type S, value "a1"


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1453 : OAInvokeC: InvokeHelper...


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1472 : OAInvokeC: InvokeHelper done.


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1608 : OAEXECMULTI: OAInvokeC done.


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1670 : OAEXECMULTI: Release 0x00451328


[0;0m4 09/20/97 14:13:30 unioadll.cpp 1673 : Rem dispatch 0x00451328 from array


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1680 : OAEXECMULTI: AttachDispatch 0x00451cc8


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2536 : GetDispatchId: "Value" => 0x6


[0;0m3 09/20/97 14:13:30 unioadll.cpp 2730 : StrToVar: src="s"


[0;0m3 09/20/97 14:13:30 unioadll.cpp 2754 : StrToVar: type S, value "UNIFACE OLE Auto"


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1630 : OAEXECMULTI: SetProperty...


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1633 : OAEXECMULTI: SetProperty done.


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1716 : OAEXECMULTI: returnvalue="E
"


[0;0m3 09/20/97 14:13:30 unioadll.cpp 1739 : OAEXECMULTI: Detaching and destroying Dispatch Driver...


[0;0m2 09/20/97 14:13:30 unioadll.cpp 1746 : OAEXECMULTI: Release 0x00451cc8


[0;0m4 09/20/97 14:13:30 unioadll.cpp 1748 : Rem dispatch 0x00451cc8 from array


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : 


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : ShowError: number     =""


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : ShowError: application=""


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2252 : ShowError: description=""


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2472 : GetDispatchDriver: ptr="P
0x00451160" => 0x00451160


[0;0m2 09/20/97 14:13:30 unioadll.cpp 2480 : GetDispatchDriver: Attach to 0x00451160


[0;0m4 09/20/97 14:13:30 unioadll.cpp 1253 : Rem dispatch 0x00451160 from array
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